
Effat University Central Library 

Data Due Slio 

Please return this book on or before 

the date shown below. 

If you failed to return on time, 
you will be fined 

SR.1.00 per book per day 

J� 

CJ -· '2:, - (_o \ 0 

2 �- lf- Z.o/o 

2 6 FF.B 7013 

!I II IHll/1111�111 mill
a31111000020066 � 
Effat University � • 

��� 

























Chapter 1 

Introduction 



Chapter 1. INTRODUCTION

1.1 Scope 

The concept of virtual laboratories has been around for many years. 

New technologies and advances in computational power have revolutio

nized the way education is delivered to students. Teaching of modern 

chemistry has remained relatively unchanged but the development of vir

tual labs, the way chemistry labs are carried out has seen a big change. 

A proposed virtual Chemistry Lab can stimulate the basic chemistry 

lab experiences in an attractive easy to use way as a lot of today's students 

are very comfortable with technological development and are very profi

cient in working with computers. This report will lead to a better under

standing as to what are the requirements for computer science students to 

develop a virtual Chemistry Lab that will result in the carrying out of expe

riments that are carried out in a virtual environment and benefit in their 

understanding of the subject as well. 

The selection of a virtual Chemistry Lab came from the experience 

with chemistry labs during school and college studies. It was seen that it 

was difficult and time taking to review the lab experiences anytime the 

students wants, the equipments are expensive and are difficult to be pro

vided all the time and the existing virtual labs were mostly either hard to 

use or not simply presented. One other reason of designing a virtual Che

mistry Lab was also connected to helping the preservation of the environ

ment. Chemical reactions and experiment always lead to the creation of 

gases and other chemicals that go toward harming the environment even 

though are a small manner, but it was still resulting in damaging the envi

ronment. Designing a virtual Chemistry Lab was seen as a solution to pro

viding a healthy environment. To use the technology we have to save our 
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planet and our health as well. Virtual Chemistry Lab is a solution to the 

need of an alternative to dangerous environmentally hazardous labs. 

1.2 About Imagine Cup 

Imagine Cup is an annual competition sponsor by Microsoft. It started 

in 2002. In 2007 there are 127,000 competitors from over 100 countries 

competed in the nine Imagine Cup invitational. The student teams were 

asked to create a software application using Microsoft technology and 

.NET Web Services. 

The Imagine Cup competition theme last year was "Imagine a world 

where technology enables us to live healthier lives." This year theme is 

about the Environment "imagine a world where technology enables a sus

tainable environment." 

Competition Categories: 

• Software Design

• Embedded Development

• Game Development

• Project Hoshimi

• IT Challenge

• Algorithm

• Photography

• Short Film

• Interface Design
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1.3 Problem Statement 

As computer science senior students, this project was selected in 

order to practice the skills we have gained during our studies, to test our 

ability to analyze, design and implement a real-life application. The selec

tion of the "virtual Chemistry Lab" came from our experience with chemi

stry labs during our school and college studies. Where it was difficult to re

view the lab experiences anytime the students wants, the equipments are 

expensive to be provided everywhere, and the existing virtual labs were 

mostly either hard to use or not simply presented. So, we thought that 

providing an easy, simple, visual way to help students to simplify their 

learning process. 

Another reason of designing "Chemistry Virtual Lab" is to contribute 

in providing a healthy environment. To use the technology we have to save 

our planet and our health as well. "Virtual Chemistry Lab" is a solution to 

the need of an alternative to dangerous environmentally hazardous labs. 

1.4 Project Objectives 

The goal of implementing "Chemistry Virtual Lab" is to learn how to de

sign professional software. Moreover, we implement this software to help 

the student in the school and university to make the chemistry lab easy for 

them. Also, we will participate in the Imagine Cup competition. 

1.5 Project Methodology 

• Studying literature review.
-

• Specifying the requirements.
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1.5.2 Specify Requirements 

After studying the literature review, the requirements of the system 

can be determined. By interviewing some chemistry lab instructors to set 

up the main project requirements based on the feedback gained. 

1.5.3 Design the Software 

During this stage the architecture and the interface design are spe

cified for the virtual chemistry lab project as well as the data model. 

1.5A Implement and Develop the Software 

The coding, developing and integrating the subsystems of the soft

ware takes place at this stage. The software tools specified in the require

ments phase are used to develop the software. 

1.6 Development Tools 

The tools that we will use it to implement our 'Virtual Chemistry 

Lab' are: 

• Visual Basic.Net.

It is a programming environment in which a programmer uses a

graphical user interface to choose and modify preselected sec

tions of code. We will use it to do the interface and writing the

code of our project.
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• SQL server.

It is a database management system integrated within the Visual 

Studio environment. We will use it to store our project data. 

• Maya.

It is a powerful and complex 30 computer graphics program. We 

will use it to draw an animated graphics in 30. 

1.7 Conclusion 

In this chapter we introduced the main idea of our project 'Virtual 

Chemistry Lab'. Also, we specify the tool that we will use ta implement the 

software. The next chapter will be for the Literature Review. We choose 

software available in the market and we describe it. 
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Chapter 2. BACKGROUND AND REVIEW OF LITERATURE

2.1 Introduction 

As we discussed in chapter one our project is to implement virtual che

mistry lab. So, in this chapter we will present the impact of the virtual lab 

in three fields: education, environment and health. Moreover, we show 

three different virtual chemistry labs that are available in the market. We 

will describe the design of these virtual labs in order to implement and de-

sign easy virtual chemistry lab. 

2.2 Virtual Labs 

Virtual Laboratory consists in using technology and computers to simu

late and model the real lab experiences. These simulation tools may be 

very powerful when they are designed very close to reality and with high 

interactivity; however their design becomes more complicated. 

Virtual labs are new phenomenon that have been introduced to the 

world Target solutions to many problems such as the diversity of learning 

styles, distance learning, environment and health issues. The next section 

will present the impact that virtual labs have in each of these fields. 

2.2.1 Virtual Labs and Education 

Modeling and simulation are common and necessary parts of a science 

education (Gilbert and Boulter, 2000). Current technologies give us the 

ability to enhance the education and the way of teaching by bringing in 

new interactive ways to solve some problems. Virtual tabs have been a 

widely used technology brought to education. 
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In a physics, chemistry, biology, networking or any lab based 

course, the traditional way of taking a lab is to bring all the students with 

the instructor in the same time into one place that is equipped with ap

propriate equipments. The students are given an exercise that has to be 

solved during the lab time, and the instructor is usually available to guide 

the students within the lab time. 

Virtual labs have simulated these lab environments. The equip

ments are graphically presented-and sometimes animated-, the exercises 

can be seen visually and the student can participate and do them by 

themselves and see the results just like in the real lab. In this digital lab 

environment students do not have to be grouped together in one place or 

at the same time, it also doesn't have to physically provide equipments 

and that saves a lot of money to schools and universities. This virtual lab is 

important to support what is done in real labs and it helps both the stu-

dent and the instructors. 

Virtual labs supplement real lab exercises to improve understand

ing. They allow students to repeat experiments that they didn't under

stand during the real lab time. They could review for exams from their own 

home or anywhere with a computer connected to the internet or with the 

software installed. Virtual labs can give the students the ability to do lab 

experiments independently, safely from dangerous materials or experi

ments and to the equipments from being damaged - like in a networking 

course-, and allow students to observe some exceptional experiments like 

how finch populations evolve over 300 years on two islands for example in 

a biology course. Virtual lab is a fun way of studying science or lab based 

courses for students (Rebecca K. Scheckler, 2003) [22]. 
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Instructors and teachers are always seeking new ways to simplify 

their teaching process and to help their students to understand the subject 

more easily. Technology provides this great tool to help them through vir

tual labs. Virtual lab is a visual help for their lectures; it is an addition to lab 

exercises. Moreover, virtual lab is an opportunity for independent explora

tion for their highly motivated students. It is also an opportunity for simple 

visualization for their struggling students. Teachers can assign homework 

that is fun, motivating, and insight building. Virtual labs are small simulators 

for teacher's laboratory. 

In addition to what virtual labs brought to the traditional education, 

it also adds a huge step to distance education. Before, it was almost im

possible to take a science online course where the practical experiments 

are important. With the invention of virtual labs it is now possible to take 

those courses and practically experiment everything the students could do 

in traditional classes. 

Finally, virtual labs were helpful tools introduced to education and 

have had their huge impact on it. Students and teachers both had a huge 

benefit from it whether they are enrolled in a traditional course or in an e

course. Virtual labs had also a positive impact on other aspects of our lives 

such as our health and the environment. These two aspects are going ta be 

presented in the next sections. 

2.2.2 Virtual Labs and the Environment 

Environment is referred ta all living and nan living things that occur 

naturally on earth. It is our surrounding, the air that we breathe, the wa-
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ter that we drink, the wildlife, and every element that affects the cycle of 

life. With the development of the human's society, the humans started to 

do some damages in the environment. They polluted the air and the wa

ter and killed the animals. Those damages grow rapidly as the industrial 

life grows to reach a dangerous level. And solutions have to be found to 

limit them. 

Pollution is considered as the most serious problem that affects the 

environment. It makes the environment an unpleasant place to live. One 

of the main sources that pollute the air and water is chemicals. "Gases 

such as carbon dioxide, which contribute to global warming, have recently 

gained recognition as pollutants by climate scientists" (Wikipedia, 2006} 

[3}. In addition to carbon dioxide, asbestos, toluene, metals such as cad

mium, mercury, and chromium are examples of toxic pollutants according 

to United States Environmental Protection Agency website. Those chemi

cals are used in laboratories, the gases that arise pollutes the air, pollutes 

the water as well when flushed into streams, lakes, rivers, underground 

water, oceans, or seas. Reducing the use of those chemicals is a solution 

that could help in cleaning our environment, and the technology makes 

this solution possible by using virtual labs. Laboratories experiments es

pecially for educational purposes in chemistry can be done using virtual 

labs more, and reduce the use of chemicals. Even if chemicals used in 

education are a very small proportion compared to chemicals generated 

by the industry, avoiding adding that little proportion to pollute the envi

ronment may be considered as a contribution for a better environment. 

Animals are also in danger of being extinct and that could occur as 

a result of air and water pollution. Many scientists said that chemicals 

have damaged wildlife populations. It is causing decreased fertility, thyro-
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id dysfunction, behavioral abnormalities, decreased hatching success, and 

feminization and demasculinization in males. Water pollution can kill large 

number of animals, in some cases killing all members of a species in an af

fected area. Furthermore, chemically polluted water usually has an im

mediate effect on aquatic life. The grinning planet web site said that many 

chemicals can have direct toxic effects on water life (Grinning Planet, 

2006). Industrial spills into rivers invariable kill fish. During 2002 and 2003, 

in US states-Wisconsin, Iowa, Minnesota, and Missouri-pollution in riv

ers and streams killed 3.5 million fish. 

In addition to pollution, animals such as mice, rats, warms, and flies 

are used for scientific experiments and killed to be used in laboratories. 

Virtual labs can be used in biology, biochemistry, and medicine classes to 

reduce the use of such animals. According to Charles R. Magel in his web 

site there are 115 million animals are killed in laboratories in the U.S. 

every year. 

A virtual lab is a solution that is dedicated by technology to enable a 

sustainable environment at a small scale. It contributes in cleaning the 

environment and save the wildlife. 

2.2.3 Virtual labs and Health 

The World Health Organization states that 2.4 million people die 

each year from causes directly attributed to air pollution (WHO, 2002). 

Everyone knows pollution can cause bad effects on human's health spe

cially air pollution. According to Environmental Protection Agency, 

Breathing in polluted air can increase the chance of having health prob

lems. And that people with h�art or lung diseases, older adults and child

ren are at great risk from air pollution (Medline Plus).Poisonous pollutants 
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are the pollutants that are known or suspected to cause cancer or other 

serious health effects. As mentioned previously, most of the toxic pollu

tants are chemicals. For example, Mercury could cause many problems to 

adults such as: heart diseases; central nervous system effects like Parkin

son's diseases, multiple sclerosis, and Alzheimer's diseases; and in severe 

cases, causing death or irreversibly damaging areas of the brain (Water 

Pollution Effects, Grinning Planet). In addition to adults, mercury could 

cause dangerous effects on fetuses." Exposure to mercury in the womb 

can cause neurological problems, including slower reflexes, learning defi

cits, delayed or incomplete mental development, autism, and brain dam

age" ( Grinning Planet,2006).By the virtual labs' rule of reducing the use of 

chemicals and controlling pollution -as mentioned previously-, it contri

butes in having a healthy environment which leads to better health life. 

In addition to controlling pollution, Virtual Labs protects the 

people who are permanently exposed to chemicals such as chemistry lab 

instructors, by reducing the danger of direct inhalation of chemical gases. 

Also, chemicals can be dangerous to their skin. Fumes can affect the skin, 

and some chemicals could burn and leave scars. Replacing some of the 

real chemistry labs with virtual ones would really help those people and 

protect their skin and body health. Virtual labs are a great gift to humani

ty. It contributes in protecting our health and wellbeing. 

2.2.4 Drawbacks of Virtual labs 

In addition to all of those advantages of virtual labs, they have several 

disadvantages as well Just like any other technology. 

The biggest drawback of virtual labs is that they are removed from the 

physical reality of the lalJis. Students will be less experienced with lab 
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tools when replaced by virtual labs. They will miss handling lab accidents. 

Also, the quality of experience in virtual labs does not have the imme

diate supervision and contact with the experienced instructors and 

teachers. 

Virtual labs have all the technical problems like any computer or 

web based technology. They require training the students to use the 

software without supervision. They rely on servers that are not always 

on service. 

Virtual labs can be used only for educational purposes. They are im

possible to use in research environment since the outcome of the expe

riment is unknown and so it is impossible to be simulated. 

As a result, virtual labs can be great tools if they are used properly 

for educational purposes as an addition to real lab experiences. 

2.3 Existing Virtual Labs 

There are a lot of successful examples of virtual Labs available to use 

in many different fields of science. Here is a review of some examples: 

2.3.1 Model ChemLab 

Model ChemLab is an interactive simulation tool that provides a 

good example of virtual chemistry Labs. This tool was originated from 

academic work in computer simulation and software design at McMas

ter University. 
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2.3.J.J General Charactaristics of Model ChemLab: 

• Model Chemlab consists of an interactive simulation incorporated

with a lab notebook workspace divided into areas for theory, proce

dures and student observations. 

• It is provided with over 20 pre-designed lab experiments and

equipments for general chemistry at high school and college level. 

• Model Chemlab is available in two Editions. Standard and Profes

sional Edition. 

� The Professional Edition has an additional tool called "LabWizard" 

which allows the instructors to add and create more or customized 

lab simulations. 

� The expandable Chemical database of the Professional Edition al

lows users to add new chemicals to Chemlab. 

� The users of the Professional Edition can capture lab simulations 

as they perform it and save it and a separate file using the "Lab 

Demonstration Mode". And they can also add comments and other 

messages to those demonstration files. Those demo files can be 

played back in both standard and professional editions. 

• Model Chem lab can work in both Windows• and the Mac• OS X

environments. 
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2.3.J.2 Model ChemLab Design: 

The Image below (Figure 2) shows the design of Model Chemlab 

and it consists of a simulation area, a lab notebook area and toolbar in 

the top. 

The simulation area is the place where the equipments and chemi

cals are placed and where the experiment visually happens. The user 

can place the equipments and move them around that area, pour the 

chemicals, mix them and do all the real lab functions in that area using 

the tool bar in the top. 

In the right of the simulation area there is the lab notebook with 

one page describing the principles and objectives, another page giving 

stepwise procedures, and a third page for recording observations and 

computations. 
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2.3.2 LiveChem 

2.3.2.J LiveChem Description:

liveChem is an online virtual chemistry laboratory developed by the
Department of Chemistry at Oxford University. It is designed for the stu
dent. liveChem provides a platform to show the visual results of chemical
reactions when mixing different salts and reagents.

• All the chemicals have photos, showing their color and name.
• The user selects one from thirteen kinds of salts.
• Then he selects one from twenty-two of reagents.
• When the user click on the "Play Movie" button, the virtual experi

ment will start.

• ft will mix the salt and the reagent. The video will show the result of
the experiment.
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2.4 Data Collection 

After meeting some chemistry department lecturers in King Abdula

ziz University, and getting the lab curriculum and the book they are using, 

we have concluded the following information about the "Salts Detection" 

Chapter they caver for the introductory chemistry course. 

Chemical substances can be divided into two categories: elements 

and compounds. All of the element's atoms are of the same kind and there 

are many examples such as: Oxygen (gas), Mercury (liquid), Sulphur and 

Cupper (Solids). The compound is consisted of different kinds of atoms and 

there are many examples for them such as: the water which is consisted of 

Hydrogen and Oxygen atoms, Carbon dioxide consists of Carbon and Oxy

gen, Carbohydrates is consisted of Carbon, Oxygen, and Hydrogen 

atoms ... etc. 

The Biggest part of chemical compounds is the Salts which are 

usually formed from the reaction between an Acid and a base for example: 

HCI + NaOH --+ H20 + NaCl 
Acid Base Water Salt 

Therefore, every salt has two parts one is acidic and the other is basic (the 

part which comes from the acid is called "Acidic Part" or "Anion", while the 

part which comes from the base is called "Basic Part" or "Cations") 

To uncover the name of a salt, we should detect the acidic part and the basic 

part separately. 

According to the reaction of the salt with different acids, the acidic 

parts of the salt can be divided into three groups: (1) diluted hydrochloric 
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acid group; (2) concentrated Sulphric acid group; and (3) miscellaneous 

group. 

When we start to detect the acidic part of the salt we should start 

with the diluted hydrochloric acid group then if it was not in this group we 

move to the concentrated Sulphuric acid group then if it was not in the 

second group we move to the miscellaneous group. This order should be 

followed exactly because if the acid part of the salt was for example from 

the first group but we started the detection from the second group (concen

trated Sulphric acid group) the salt will react but the results in this case will 

be false. 

In the same way the basic part of the salt is divided into six groups, 

the Cations of a group precipitates when reacted with a specific reagent. 

When detecting either the Acidic or the basic parts we start by the group 

detecting reagent, and then when we have a negative result we move to the 

next group. Or if we have a positive result we should make some confirming 

tests to confirm the result. 

The following steps show an example from the chapter. It is about 

detecting the Carbonate Acid part of the Sodium Carbonate Salt assuming 

that the salt is unknown to the experimenter: 

1. The main detection experiment: mixing the solid salt with the diluted

Hydrochloric acid. If the result was bubbling with a rising of a gas that has

no color or smell, then the acid part of the salt is in the Diluted Hydroch

loric Acid Group ( for this Salt the gas is CO2):
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A confirmation experiments must be done to know which acid radical it is. 

2. The First Confirmation Experiment: mixing the solute salt (solid salt+

water) with Mercuric Chloride. If the result is a brown lees that arises 

immediately, then the acid part of the salt might be Carbonate and the 

lees is mercuric carbonate HgC03 in this salt: 

Another confirmation experiment must be done to make sure the Acid 

radical of this salt is Carbonate. 

3. The Second Confirmation Experiment: mixing the solute salt with the

Magnesium Sulphate. If the acid radical is carbonate, the result will be

white lees that arise immediately, and this lees is Magnesium Carbonate

Na2S04 in this selected salt:

That was a simple example of how to detect the Acid part of a salt. 

In this example we concluded that the Acid part of the salt is "Carbo

nate". 

2.5 Tools Needed 

To be able to complete the project and implement the desired virtual 

chemistry lab tool, there must be some tools to be used. In this part, a 

small description of each one of them is stated. 
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2.5.1 Visual Studio 

Microsoft first released Visual Studio in 1997, bundling together many 

of its programming tools for the first time. Visual Studio 97 was released in 

two editions, Professional and Enterprise.Microsoft Visual Studio is an 

integrated development environment (IDE) created by Microsoft. It is a 

suite of applications. It uses to develop console and Graphical User 

Interface GUI applications. Visual Studio helps programmers create a con

sole applications, Windows applications, Windows services, Windows Mo

bile applications, ASP.NET applications, and ASP.NET web services. It runs 

on Microsoft Windows, Pocket PC, smart devices, and the Web. 

Visual Studio includes the following: 

• Visual Basic .Net

• Visual C# .Net

• Visual J#

2.5.1.1 Visual Basic: 

Visual Basic (VB) is a programming environment from Microsoft in which 

a programmer uses a graphical user interface to choose and modify prese

lected sections of code written in the BASIC programming language. 

These are some various applications that can be built using Visual Stu

dio. The majority of the applications are written for at least one of the op

erating system such as NT, ME, 2000, and XP. 
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• Console applications:

It runs from the command line. It doesn't include a graphical interface. 

• Windows applications:

These are Windows desktop applications written using the .NET applica

tions. The .NET framework must be on any computer that will run the ap

plication. A familiar Windows application is Notepad. It is include by de

fault in the installation of all windows operating system. 

• Windows services:

Services are applications runs in the background while the computer is 

running. It will perform scheduled tasks or handle continuous network re

quests. 

• ASP .NET applications:

ASP.NET is a powerful technology is used to create dynamic web applica

tions that have a database. Many popular websites are written using 

ASP .NET such as e-commerce giants like Dell. 

• ASP.NET web services:

ASP.NET provides a complete web services model. It creates web services 

quickly and easily. 
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• Windows Mobile applications:

Windows Mobile applications run on devices that include the Compact 

framework; For example Pocket PC devices, and all cell phones that run

ning the Microsoft Smartphone platform. 

• Visual Studio add-ins:

You use Visual Studio to write new functionality to be added into Visual 

Studio. Visual Studio also includes projects to organize your application, 

work with databases, create reports, and more. 

2.5.1.2 SQL In Visual Studio.Net: 

Visual Studio provides an extensible model far adding new projects to 

Visual Studio. There are many Microsoft applications integrate directly into 

the IDE. Some of the most common include SQL Server Reporting Services 

and Visual Studio Tools for Office. 

SQL is the international stander database language. The name SQL 

stands for Structured Query Language. It can create, retrieve, change, or 

delete data. The formal definition of SQL comes from the American Na

tional Standards Institute (ANSl). It is international stander specified by in

ternational Organization for Standardization {ISO). 
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SQL is a computer language design to get information from the data

base that stored in database. SQL is easy to use. It allows people to handle 

the information in new ways. It makes the information powerful by bring

ing it to the people when they need it. 

SQL is an important part of modern programming. It used in building a 

Web application, a client-server Windows application, an enterprise solu

tion encompassing Windows, the Web, distributed components such as 

XML Web Services or .NET Remoting , that using a database. 

2.5.2 Maya 

It is a powerful and complex 30 computer graphics program developed 

by Alias Systems Corporation, but now owned by Autodesk. It converts 

everything from modeling and texturing to animation, character animation, 

and paint effects. Maya is used in the film, TV industry, and for computer 

and video games such as Spider-Man and the Lord of the Rings. 

The software has two versions: Maya Complete (the less powerful 

package) and Maya Unlimited. Maya Personal Learning Edition (PLE) is 

available at no cost for non-commercial use. Maya was released for the lRIX 

operating system but now it used in the Microsoft Windows, Linux and Mac 

OS X operating systems. The latest version of Maya is 2008 (9.0). It was 

released in September 2007. 

Maya features a particle system for handling masse like steam and 

water drops. Dynamic fields allow adding gravity, wind and vortexes. Also, it 
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allows adding effects such as blowing leaves or tornados. It has special tools 

to give artists the ability to brush and style particles like hair and fur. 

Maya effects are built-in programs that make it easy for users to 

create complex animation effects such as smoke, fire and realistic water 

effects. It has many options and attributes for tuning the results. 

2.6 Conclusion 

This chapter has presented the methodology and architecture of three 

virtual laboratories. Which are Chemlab, liveChem, and virtual reality phys

ics simulation (VRPS). These virtual labs are useful examples of simulating 

realistic experiments, and reducing the dangerous and cost of them. 

The studying of different virtual lab examples in addition to the review 

of the advantages and disadvantages of using virtual labs and their impact 

on three different important fields education, environment and health, is 

an aid to set the requirements of our chemistry virtual lab. 
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Chapter 3. REQUIREMENTS SPEOFICATION 

3.1 Introduction 

The proposed product is a virtual Chemistry LAB that simulates the 

basic chemistry lab experiences in an attractive easy to use way. In this 

chapter, all requirement specification and features which are needed for 

designing, implementing, and testing the software are specified. 

The chapter will include the basic requirements of the software, de

tailed functional requirements, and the software constraints. 

3.2 Basic Software Requirements 

This part should present the basic requirements of the project to 

reach the goal of implementing the chemistry lab simulation software. 

1. The software should visualize the lab experiences in an attractive

graphical user interface using visual Basic 2005.

2. The software should allow the user to interact easily with the pro

gram.

3. The software should use some animated graphics to show the result

of the experiments in an attractive way.

4. The software should be able to adapt many chapters of chemistry

lab experiments to be added.

5. The software should be able to adopt many experiments to be add

ed within a chapter.

6. For this project, the software should show one complete experi

ment from the �hapter of "Salts Detection", "Acid Detection" Sec-
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tion, "Group 1: Diluted Hydrochloric Acid." Group, "Carbonate Salt 

Acid Detection" basic experiment. 

7. The software should use a database to store the data needed for

this experiment such as images, tutorials, chemicals names, ... etc to

minimize the speed . The database should be divided in a way that

allows integration of more experiments and chapters in the future.

3.3 Software Functional Requirements 

This part should cover all the functional requirements of the software 

that shows detailed guidelines to be followed in the design, implementa

tion and testing phases. 

Because of the time constraint, the project will cover only one lab ex

periment- as mentioned above- and it should follow the following re

quirements: 

1. First, the user should be able to select the chapter desired (only the

chapter of "Acid Detection" will be available in this version). The

software interacts with the database to get the sections related to

the chosen chapter.

2. Second, the software should display the section choices to the user

based on the selected chapter. The choices of the sections "Acid

Radicals Detection", "Base Radical Detection", or "Salts Detection"

must be given for this chapter. Those section choices are loaded

from the database based on the previously chosen chapter.
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3. The software shall provide a choice ta go back to the chapter selec

tion step to the user.

4. Third, for the "Acid Radica Detection" selection, the software should

display the lab environment scene with the chemicals and tools re

lated to "Groupl: Diluted Hydrochloric Acid" group by default. The

software interacts with the database to get the salts acid radicals,

detectors, and tools related to the group.

5. The lab environment scene should provide a list of salts, detectors,

and tools for all of the groups in all of the sections (Acid radical salts

section, Base radical salts section, and salt detection section) in ad

dition to a constant water tab, a flame provider, and a working area

where the experiment is handled.

6. The user should be able to select any group he/she desired in the

lab environment scene and the listed salts acid radicals, detectors,

and tools should change according to the selected group.

7. The software should give the user a choice to be guided through

his/her desired experiment or not.

8. If the user chaoses. to be guided through the experiment the soft

ware should ask the user which Acid radical he/she wishes to detect

- in this. version- . then, the system will interact with the database

to load the tutorial needed for the experiment and follows the fal

lowing sequence of actions: 
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a) The software should display a dialog box telling the user

which salt to pick from the list of salts displayed.

b) Once the user picks the correct salt, the previous dialog box

will disappear and display a new dialog box telling the user

which detector should be selected from the detectors list.

c) Once the user picks the right detector, the dialog box disap

pears and the software shows the animated result in the

work area.

9. The software should explain the result with the related chemical

equation if the experiment is correct.

10. If the us.er chooses. not to be guided through the experiment, the

software should give the user the ability to do the previous steps (a,

b, and c) in step8 without guidelines from the software.

11. The user can print the experiment guided.

12. The software should give the user the choice of quitting the experi

ment and change it.

The software should allow the us.er to go back the section selection phase. 

3.4 Conclusion 

At the end of this chapter, we specify the requirement specification of 

the Virtual Chemistry Lab. The software should be easy to use. Moreover, 

it should be presented in animated graphic. ln the second part of this 

chapter, we show the functional requirement of the software. It identifies 

the steps that will be followed in the software design. 
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Chapter 4. SoFTWARE DESIGN 

4.1 Introduction 

After specifying the requirements of the "Virtual Chem. Lab" soft

ware, the design of the software have to be specified. Designing software 

simplifies the implementation process since it gives a general view of the 

software. 

This chapter concerns of the first design of "Virtual Chem. Lab" 

software. The design is shown in four different ways each represents a dif

ferent perspective. Architecture design, data modeling with ER diagram, 

user interface design, and a sequence diagram will be discussed in details 

in this phase. 

4.2 Architecture Design 

The architecture design shows the general structure of the 

software. It shows the basic components of the software and the re

lationships between them. The Architecture design of "Virtual Chem. 

Lab" is shown in Figure9. 
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sections related to the selected chapter will be shown and the user can se

lect the desired one. In this version there will be three sections under the 

"Salts Detection" chapter displayed: Acid Radicals, Base radicals, and Salts 

(only "Acid Radicals" section is implemented in this version). After the sec

tion selection layer, the software will go ta the Main experiment area layer 

where the environment of the lab experiment is shown. 

Under the min experiment area layer, the software gives the user 

the ability ta select the desired group (group selection layer). For the Acid 

radi cals s ection there will be three groups: Diluted Hydrochloric Acid 

Group, Concentrated Sulfuric Acid Group, and Barium Chloride Group. Only 

"Diluted Hydrochloric Acid Group" -where the Hydrochloric Acid is used ta 

detect the Acid part of the salt- can be selected in this version. Under the 

selected group there are five components (group component layer). The 

components are: Chemicals, Detectors, Tools, Result Area, and Help menu. 

Those components contents differ as the group changes except the result 

area which is static in all chapters. 

Chemicals are the chemical components used to be experimented. 

Detectors are chemical or nan chemical components that are used in the 

experiment ta cause a change in the chemical component when mixed 

with it. Tools are the tools that can be used while doing the experiment. 

The result area is the area where the selected components and results are 

displayed and it contains three main things: the mixing option when the 

components are chosen and wanted to be mixed, the result animation 

where the animated result of the experiment is displayed, and the result 

text which is displayed with the result animation and it explains the result 

to the user. Finally, the Help menu which has three main components, 

"How to Use" which is a manual of how to use the software in general, 
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"Tutoriar' which shows a text of all of the steps of a particular experiment 

so the user can print for review, and "Step by Step Guidance" where the 

user will be guided through the experiment desired. 

For this version, the components that will be listed in the main ex

periment area under the "Diluted Hydrochloric Acid" group as shown in 

Figure 9 for each of the Chemicals, Detectors, and Tools are: 

• The Chemicals listed are:

o Na2C03: Sodium Carbonate salt which represents the carbo

nate Acid radical ((03 -
2) in the Diluted Hydrochloric Acid

group.

o NaHC03: Sodum Bicarbonate salt which represents the Bicar

bonate Acid Radical (HCQ3 -) in the Diluted Hydrochloric Acid

group.

o NaN02: Sodium Nitrite salt representing the Nitrite Acid Radi

cal (N02 -)in the Diluted Hydrochloric Group.

o Na2So3: Sodium Sulfite salt that represents the Sulfite Acid

Radical (S03 -2) in the Diluted Hydrochloric Acid group.

o Na2S203: Sodium Thiosulfate salt representing the Thiosulfate

Acid radical (S203 -2) in the Diluted Hydrochloric Acid group.

o Na2S : Sodium Sulfide salt which represent the Sulfide Acid

Radical (S-2) in the Diluted Hydrochloric Acid group.
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• The Detectors listed are:

o dil. HCI : Diluted Hydrochloric Acid.

o HgCI : Mercuric chloride.

o MgS04: Magnesium Sulfate.

o FeS04: Ferrous sulfate.

o dil. H2So4: Diluted Sulfuric Acid.

o KMn04: Potassium Permanganate.

o AgN03: Silver Nitrate.

o Pb(CH3CQO)i: Lead Acetate.

o K2Cr201: Chromium potassium oxide.

• The listed tools which might be used in any experiment in the chap

ter are:

o Dropper: is used ta make drops of any liquid.

o Beaker: This is used as a container.
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o White Papers: they are strips of white papers used to be dip

ped in any detector then when dipped in specific chemical

the paper's color changes.

Finally, as seen in the figure, the database is connected to all the 

layers and the group components. Chapter selection Layer communicates 

with the database to get the chapters' information; the section selection 

layer also communicates with the database to get the sections' informa

tion, the group selection layer communicates with the database to get the 

groups' information, the chemicals, tools, detectors, results area, and help 

all communicates with the database to get the needed information. 

This part presented the overall abstract architecture design of the 

software. Next, the Data model including the ER diagram of the software 

will be shown. 

4.3 Data Model 

The Virtual Chemistry Lab has data to be store in the database. The user 

will select the chapter. The chapter has many sections. Also, the section 

has many groups. Therefore, the user will select the sections and the 

groups. Then he/she chooses the chemical and the detector. After that, 

the experiment result will appear in the screen. The software will save all 

these information in database. 

4.3.1 ER Diagram 

It has sixteen tables. These tables have relation to each other. All the 

table must has a primary key. The chapter table has many sections. So, it 

will be linked to the section table by the primary key (chapterlD ). Also, the 
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section table linked to the group table by the primary key (sectionlD). 

Moreover, the chemical, the detector and the tool table linked to the im

age table by the primary key (lmagelD). The chapter table linked to the 

tool table through the chapter-tool table. Also, the group table linked to 

the chemical table through the group-chemicals table. Then ta show the 

result of this experiment the chemical table must be linked to the experi

ment table through the exp-chemical table. 

The experiment has many steps. So, the experiment table content 

linked to the step table by (experimentlO). Likewise, the experiment has 

many results and the result has many outputs. So, the experiment table 

linked to the result table by the primary key (experimentlD). Also, the re

sult table linked to the output table through the result-output table. The 

experiment result has animation. Therefore, it will be connected to the 

animation table by the primary key (AnimlD). 
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(3) A combo box containing the list of group related to the selected sec

tion.

(4) List of buttons representing the salts or chemicals related to the se

lected group that will be used in the experiment and they are shown

as t est tubes labeled with the salts symbols.

(5) List of buttons representing the detectors related to the selected

group that might be used in the experiment and they are shown as

bottles labeled with the detectors symbols.

(6) Set of buttons representing the tools related to the whole chapter

that can be used in the experiment.

(7), (8) Two buttons displaying the Tab and the Flame and they are con

stant in all the chapters. 

(9) A group box representing the work area where the experiment is dis

played. This group box contains three main components (10), (11),

(12).

(10) A picture box to display the experiment components selected by

the user and the result after mixing them.

(11) A button "MIX" that the user clicks to combine the experiments

components to see the results.

(12) A label to display the chemical equation explaining the experiment.
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This form is a sample of all the Step by Step Guidance forms and it 

contains only two components, a label displaying the Step (l}, and a 

NEXT button (2) that takes the user to the following step form. 

4.5 Sequence Diagrams 

Finally, after viewing the architecture design, data model, and inter

face design, this part will present the dynamic behavior of the software. It 

will show the function interactions in the software as well as the relation

ship between the interfaces. The sequence diagram represents the se

quence of interaction between the interfaces. It shows the interaction be

tween the user, the interfaces, and the database. It also shows what each 

of them do, communicates with who, and when. Figure 16 shows the main 

sequence diagram of "Virtual Chem. Lab". 

The following points explain the components in the following se

quence diagrams for better understanding: 

• The columns in the sequence diagram represent the user, software in

terfaces (Chapters selection, Section Selection, and Group Selection),

and the database.

• The dashed lines represent the life lines of the user, interfaces, and da

tabase.

• Solid rectangles represent the activation state of them.

• The arrows between the interfaces, user, and database represent the

interaction between them.

o Solid arrows represent function calls and messages.

o Dashed arrows represent the return of the function or reply.
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1. The user opens the software by double clicking over the software icon.

Then the chapter selection form will appear showing a welcome message

and a list box of chapters.

2. The chapter selection frame will then interacts with the database re

questing all the names of the chapters stored.

3. The database then will respond and send the names of the chapters back

to the chapter selection form which will display those names in the list

box.

4. The chapter selection form then waits for the user to select the desired

chapter.

5. The user selects a chapter and clicks on a next button.

6. Then, the section selection form will be opened.

7. Section selection form will then sends a request to the database to send

the sections name under the selected chapter.

8. The database will return the sections names which will be displayed to

the user as buttons in the section selection form.

9. After that, the section selection form waits for the user to select the

desired section.

10. The user will then select a section.

11. The main experiment area frame will be opened.

12.Since the groupl's information is always initially displayed by default, the

main experiment frame will request the groupl information and the

groups names related to the selected section from the database. Group

information are the list of chemicals, list of detectors, list of tools related

to the selected group displayed as buttons.

13. The database then sends the group l's information and the names of the

groups to the main experiment area frame where they will be displayed.
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14.Then, the main experiment area form will wait for the user's group selec

tion (the user might want a group other than the default groupl). The

group names are displayed in a list box.

15.The user will then select the desired group from the list box in the main

experiment frame.

16.The main experiment frame will request the selected group's information

from the database.

17.The database will then return the group's information to the main expe

riment frame.

18.The main experiment frame will wait for the user's selection from chemi

cals, detectors, and tools.

19. The user will then select the desired chemical, detector, and tool.

20. The main experiment area frame will display the selected components in

the work area box.

21. The user then request mixing the components by clicking on the mix

button.

22. The main experiment area frame then, requests the result information

from the database.

23. The database then returns the result information. Result information is

the animation, output components to display the equation and the text

result explanation.

24. The main experiment area frame displays the result information in the

work area box.

25. The user requests from the main experiment area frame to close the

software.

26. The main experiment area frame finally closes the software.

Another scenario is shown in Figure 17 when the user wants to print

out a list of the experiment's steps. And the sequence is explained as fol

lows: 
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1.18 Steps from 1 to 18 are the same as the steps of the previous scenario 

from 1 to 18.

19. The user requests help from the main experiment area form by clicking

on the help tool bar.

20. The main experiment area form then displays a list of help options.

21. The user selects on the tutorial option from the help menu.

22. The main experiment area form display a message to the user asking

which chemical does the user want to view its experiment in a dialog

box.

23. The user then selects the desired chemical from the dialog box.

24. The main experiment area form communicates with the database to get

the steps of the experiment related to the selected chemical.

25. The database then returns the steps to the main experiment area frame.

26. The main experiment area form then displays the list of steps in a text

file.

27. The user then requests a print order by clicking on the print button.

28. The main experiment area form then prints out the steps through the

printer to the user.

29. The user requests from the main experiment area frame to close the

software.

30. The main experiment area frame finally closes the software.
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Chapter s. SOFTWARE IMPLEMENTATION 

5.1 Introduction 

The aim of this chapter is to describe the implementation phase of 

the project. It this chapter we will describe the updated database. Also, it 

describes the design of the software. 

5.2 Database Update 

5.2.1 ER Diagram 

The database table had updated to make the program work correct

ly. We added tables to the database to link the tables to each other. After 

the updated the database has twenty tables. (New tables highlighted in 

red, in figure 19) These tables have relation to each other. All the table 

must have a primary key. 

The chapter table has many sections. So, it will be linked to the sec

tion table by the primary key (chaplD). Also, the section table linked to the 

group table by the primary key (seclD). Moreover, the chemical, the detec

tor and the tool table linked to the image table by the primary key (lmage-

10). The chapter table linked to the tool table through the 

Group_Exp_Tools_Chap table. Also, the group table linked to the chemical 

table through the Group_Exp_Chem table. The experiment table stores 

the experiment name and linked the group and the chemical table through 

the Group_Exp_Chem. Also, it linked the detector and the group table with 

the Group_Exp_Det table. Then to show the result of this experiment the 

experiment table must be linked to the results table through the Exp

Result table. 
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The experiment has many steps. So, the experiment table content 

'inked to the step table by (ExplD). likewise, the experiment has many re

sults and the result has many outputs. So, the experiment table linked to 

the result table by the primary key (ExplD). The experiment result has 

animation. Therefore, it will be connected to the animation table by the 

primary key (AnimlD). The output table connects to the experiment table 

to show the equation result. The conclusion table shows the final result of 

the experiment. It connects to the experiment table by the Conc_Exp ta

ble. 
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primary and the foreign key. The tables that highlighted in figure 19 are 

the new tables. 

The tables that added to the database are: 

• Conclusion Table

The conclusion table shows the final result of the experiment. It has 

two field name ID and description. This table is added to the data

base to store the conclude result for experiment. 

• Conc_Exp Table

This table connects the experiment table with conclusion table. It 

has two foreign key ConclD and ExplD. 

• Exp_OutputTable

This table connects the experiment table with the output table. It 

has two foreign key ExplD and OutputlD. 

• Group_Exp_Det Table

This table connects the group table with the detector table. It will 

show all the detectors that related to each group. It has three for

eign key GrouplD, ExplD, and DetlD. 
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• Exp_Step Table

The experiment has step to follow. So, these step stored in table in 

the database. The experiment table linked to the step table through 

the Exp_Step table. It has two foreign key ExplO, and SteplO. 

• Exp_Result Table

Each experiment has result. So, these result stored in table in the 

database. The experiment table linked to the result table through 

the Exp_Result table. It has two foreign key ExplD, ReslD, and De

scription. The description filed is to describe the final result for the 

experiment. 

5.3 User Interface Design 

Bin Hayan software consists of four main forms and some secondary 

forms and their interface designs are presented in this part. We imple

mented the forms using Visual Studio 2008. 
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that shows the steps of doing the complete experiment after se

lecting the user's choice from the secondary form that will be 

shown in figure 29,30. 

2) A combo box containing the list of group related to the selected

section.

3) list of buttons representing the detectors related to the selected

group that might be used in the experiment and they are shown

as bottles labeled with the detectors symbols. The bottles were

designed using 30 Max. The labels were drawn using in the Pho

toshop.

4) List of buttons representing the salts or chemicals related to the

selected group that will be used in the experiment and they are

shown as test tubes labeled with the salts symbols. Also, we

used 30 Max to draw the test tubes and Photoshop for the la

bels.

5) The Label representing the tools related to the whole chapter

that can be used in the experiment. The tools are baker, drop

per, and white paper. These items were drawn in 30 Max. As

shown in figure 24.

6) When the detector and the salt or chemical are selected, the

button "MIX" appears. The user clicks to combine the experi

ment components to see the results. When the user clicks the

button, the result form will be displayed. As shown in figure 25.
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5.4 Sequence Diagrams

The sequence diagram designed previously is enhanced as moreforms are added and changed. The Final sequence diagram is shown andexplained in this part.

The following two figures will show two scenarios of using the software. One shows the basic scenario, and the other represents the use ofthe other forms:
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The previous figure represents the main scenario to do an experiment. 

It shows the interaction between the User, Start Form, Chapters Form, 

Sections Form, Main Form, and the Result Form. The following points will 

explain this scenario: 

1. The user opens the program, and that loads the Start Form that

sows the splash video and waits for the user's action.

2. When the user clicks on the "Start" button in the Start Form, the

Chapters Form will be loaded.

3. When the Chapters Form is loaded the list of chapters will be re

quested from the database and displayed into the combobox in the

Chapters Form.

4. When the user selects the chapter from the combobox and clicks on

the "Next'' button, the Sections Form will be loaded.

5. When the Sections Form is loaded. The list of Section under the

previously selected chapter will be requested from the database,

and shown to the user as buttons in the Sections Form.

6. When the user clicks on the desired section, the Main Form will be

loaded.

7. When the Main Form is loaded, the list of groups' names under the

previously selected section will be requested from the database and

displayed in the combobox in the Main Form. Also, the chemicals,

detectors, and tools of the selected group will be requested from

the database and displayed in their proper buttons placed in the

Main Form.

8. When the user clicks on his choice of chemicals button, the selected

chemical will be displayed in the display area.

9. When the user clicks on his choice of detectors button, the detector

will be displayed in the display area and the mix button will be

shown.
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10. When the user clicks on the "MIX" button, the Result Form will be

loaded.

11. When the Result Form in loaded, the animation, outputs, conclu

sion, and results related to the previously selected chemical and de

tector will be requested from the database and displayed in the Re

sult form.

12. When the user clicks on the "Close" button, the Result Form will

close while the Main Form is stell displayed.

13. When the user clicks on the File > Close menu item button, the pro

gram will close.

This scenario is one of the scenarios that might be followed when doing 

an experiment with Bin Hayan software and it shows the interaction be

tween the main forms in the software. The following figure will show 

another scenario to show the interaction with the About, How to Use, and 

Tutorials forms with the software. 
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The first seven steps are the same as the first scenario (i.e. steps 1- 7 

are repeated): 

1. The user opens the program, and that loads the Start Form that

shows the splash video and waits for the user's action.

2. When the user clicks on the "Start" button in the Start Form, the

Chapters Form will be loaded.

3. When the Chapters Form is loaded the list of chapters will be re

quested from the database and displayed into the combobox in the

Chapters Form.

4. When the user selects the chapter from the combobox and clicks on

the "Next" button, the Sections Form will be loaded.

5. When the Sections Form is loaded. The list of Section under the

previously selected chapter will be requested from the database,

and shown to the user as buttons in the Sections Form.

6. When the user clicks on the desired section, the Main Form will be

loaded.

7. When the Main Form is loaded, the list of groups' names under the

previously selected section will be requested from the database and

displayed in the combobox in the Main Form. Also, the chemicals,

detectors, and tools of the selected group will be requested from

the database and displayed in their proper buttons placed in the

Main Form.

8. When the user clicks on the "Help"> "About Bin Hayan" menu strip

item button, the About Form Is loaded displaying information about

the software in text boxes and a picture with the logo in a picture

box.

9. When the user clicks on the "OK" button, the About Form will close

while the main Form is still displayed.
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10. When the user clicks on the "Help" > "How to Use ... " menu strip

item button, the HowToUse Form will be loaded displaying a text of

the steps to be followed to use the software in a rich text box.

11. When the user clicks on the "OK" button, the HowToUse Form will

terminate while the Mian Form is still displayed.

12. When the user clicks on "Help" > "Tutorials ... " menu strip item but

ton is clicked, the Tutorial Form will be displayed.

13. When the Tutorials Form in loaded, the list o chemicals will be dis

played in the chemicals combobox, the list of detectors will be dis

played n the detectors combobox.

14. When the user selects items from both comboboxes, the tutorials

will be requested from the database and displayed to the user in

the listbox in the Tutorials Form.

15. When the user clicks on the "Print" button, a message box will be

displayed to the user with the printing status, and the print request

will be sent to the default printer.

16. When the user clicks on the "Close" button, the Tutorials Form will

terminate while the Main Form is still displayed.

17. When the user clicks on "File" > "Close" menu strip Item button in

the Main Form, the program terminates.

Those two scenarios shows the interactions between all the pro

gram forms used to implement the "Bin Hayan" virtual chemistry lab tool. 

Next, the implementation of each form will be explained briefly. 

5.4.1 The Behind Code Description 

This part will explain the implementation behind each form shown in 

the previous sequence diagrams. Each section will present a general ab

seudo-code, however code details are available in appendix A. 
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a. Connect to the database and creates an instance of the sec

tions table from the database.

b. Creates an array and fill it with the sections names from the

database where the chapters ID row = the chapter ID stored

in the chapters form.

c. Display the names of the sections from the stored array to

the three buttons in the form (selbtn.text, sec2btn.text,

sec3btn.text).

2. When clicking on the section button ( Seclbtn Click () ) as

shown in figure 36. The complete VB code can be found in Appendix

A.

a. Retrieve the section ID from the database where the section

name = the text in the button (Seclbtn.Text), and save it in a

public variable.

b. Use the (next Form () ) function to close the current form

(SectionsForm) and create a new instance of the Main Form

and show it.

3. When clicking on the BACK button (backbtn _ Click () ) as

shown in figure 37. The complete VB code can be found in Appendix

A.

a. Close the current form (sectionsForm).

b. Show the previous form (ChaptersForm).

4. When clicking on the Cancel button (btnCancel Click () ) as

shown in figure 38. The complete VB code can be found in Appendix

A.

a. Close the current form (SectionForm).
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1. When the form is loaded (MainForm _ Load () ).The complete VB

code can be found in Appendix A.

a. Set the URL of the background video and play it.

b. Retrieve data tables from the database to be used later. (Groups

table, chemicals table, chemical group table, detectors group ta

ble, detectors table, and images table).

c. Fill the combobox (ComboBoxl) with the list of group descrip

tion retrieved from the database.

d. Set the combo box to select the first item by default.

e. Call the (set Form ()) function which:

i. Initializes all the variables. (An array to hold the buttons

of the detectors bottles (btnButtlel,2,3,4,5,6, 7,8,9), and

an array to hold the buttons that holds the chemicals

tubes (btnTubel,2,3,4,5). Empty the arrays to hold the

chemical IDs, chemical symbols, detector IDs, detectors

symbols, detectors images, chemical images, and the

tools. Hide all the chemicals and detectors' picture boxes

and make them invisible.

ii . Makes the display area (pnllnputs panel), selected 

detector and tube picture boxes (Buttlell, tubell), the 

picture boxes that represents their symbols (picButtle, 

picTube), and the "MIX" button (btnMix) to invisible 

iii. Get the ID of the selected group by searching in the

groups table for the group description that matches the

selected item in the combobox (comboboxl).

iv. fill the chemicals ID array with the IDs of the chemicals

from the chemical-group table in the database where the

group ID matches the Group ID of the selected group.
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v. Fill the chemicals symbols array with the symbols of the

chemicals from the chemicals tables where their ID's

matches the ID's stored in the chemicals IDs array.

vi. Fill the detectors IDs array with the IDs of the detectors

from the Detector-group table in the database where the

group id matched the selected group.

vii. Fill the detectors symbols array with the symbols of the

detectors from the detectors table in the databasewhere

their IDs matches the IDs stored in the detectors IDs

array.

viii. Fill the symbols picture boxes of the detectors and

chemicals with the symbols stored in the symbols arrays ,

and show the picture boxes and set them to be visible.

ix. Get the images of the chemicals from the images table in

the database where the image id matches the image id in

the chemicals table where the chemical IDs matches the

ones stored in the chemicals id array.

x. Get the images of the detectors from the images table in

the database where the image id matches the image id in

the detectors table where the detectors IDs matches the

ones stored in the detectors IDs array.

xi . show the picture boxes of the chemiacals and the 

detectors and set them to be visible. 

xii. Set the tools (set Tools ()) by connecting to the

database and retriveing the data in the groups

experiments-chapters table and the data from the tools

table. Then, initializing three arrays for the tools IDs, tools

images IDs and the images to be empty. Then, fill the

tools ID array by searching in the groups-experiment-
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chapters table for the chapter ID that matches the 

chapter ID chosen in the chapters form, then, and gets 

the tools ID of that row to be stored in the array. Fill the 

tools images IDs array by searching for the tools IDs in the 

tools table that matches the tools IDs stored in the tools 

ID array and retreive it's image ID. The tools images array 

is filled by retreiving the images from the images table 

that its Id matches the images ID from the tools table. 

Finally, fill the labels and picture boxes of the tools from 

tools array and images array. 

2. When clicking on any chemical button (btnTubel_Click ()) as

shown in figure 41. The complete VB code can be found in Appendix A.

a. Call the (btnTubeClick ()) function with the number of

button(0,1,2,3,4,5) as a parameter. The function hanles the

following:

i . First, it checks if a detector have been picked (btnButtle 

have been clicked). If so, the "MIX
n 

button is shown and 

set to be visible. 

ii . Then, make the pnllnputs panel and the picTube picture 

box visible, and hide the selected button. 

iii. Set the picTube back ground picture to the picture of the

clicked button with its symbole.

iv. if there was another tube button clicked before, make it

visible and set its images.

3. When clicking on any detector button (btnButtlel_Click ()) as

shown in figure 41. The complete VB code can be found in Appendix A.

It follows the same logic as the btnTube_click() ... 

4. When clicking on the uMIX
» 

button (btnMix _ Click ()) as shown in

figure 41. The complete VB code can be found in Appendix A.

96 



a. Call (f indResul ts ()) function that finds the variables

needed to display the results in the result form and that is done

by:

i. Initialize an array to hold the experiments IDs of the

chemicals and an array to hold the experiments IDs of the

detectors.

ii. Find the chemical 10 of the selected chemical, and the

detector ID of the selected detector.

iii. Fill the chemicals experiments array by searching in the

chemical-group table in the database for the experiments

IDs that their chemical 10 matches the selected chemical

ID. Also, fill the detectors experiments array from the

detectors-group table in the database using the same way

the chemicals experiments array was filled.

iv. Find the matching experiment 10 in both the chemicals

experiments and detectors experiments arrays. (that is

the desired experiment).

v. Get the experiment-results, results, and animations data

tables information from the database.

vi. Find the result ID and description from the experiment

result table where the experiment 10 = the experiment ID

found in the previous steps.

vii. Find the animation 10 and result title from the results

table where the result ID in the table matches the one

found in the previous step.

viii. Get the experiment-outputs, outputs data tables'

information from the database.
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ix. Find the outputs IDs from the experiments-outputs tables

from the database where the experiment ID in the table

matches the experiment ID found in the previous steps.

x. Find the output symboles from the outputs table in the

database where the output ID in the table matches the

ID's in the previous step.

xi. Store the inputs data (the selected chemical and

detector) in public variables to be used in the Results

Form.

xii. Store the outputs n public variables to be used in the

Reulst Form.

b. After the findResults() function is executed, a new instance of

the Result form is set and the result form is loaded.

5. When the Tools tary Open label is clicked (lbl TrayOpen _ Click ())

as shown in figure 41. The complete VB code can be found in Appendix

A.

a. Make the tools panel visible (pnITools).

b. And make the open tools tray table invisible and hide it.

6. When the Tools tary Close label is clicked

(lbl TrayClose _ Click ()) as shown in figure 41. The complete VB

code can be found in Appendix A.

a. Make the tools panel invisible (pnITools) and hide it.

b. And make the open tools tray lable visible.

7. When the File > New strip menu item is clicked

(NewToolStripMenuiteml_ Click ()) as shown in figure 41. The

complete VB code can be found in Appendix A.

a. The current form (Main Form) is closed.

b. The (Chapters Form) is loaded again.
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8. When File > Close strip menu item is clicked

(CloseToolStripMenuiteml _ Click ()) as shown in figure 42.

The complete VB code can be found in Appendix A.

a. Close the current form (Main Form) which will eleminate the

program.

9. When Window > Previous menu strip item is clicked

{PreviousToolStripMenuitem _ Click ()) as shown in figure

43. The complete VB code can be found in Appendix A.

a. Close the current form (Main Form).

b. Load the previous form (Sections Form).

10. When Window > Reset menu strip item is clicked

(ResetToolStripMenuitem _ Click ()) as shown in figure 44.

The complete VB code can be found in Appendix A.

a. Call the (set Form ()) function explained earlier to return the

main form to its initial states.

11. When Help > About menu strip item is clicked

{AboutToolStripMenuiteml _ Click ()) as shown in figure 44.
The complete VB code can be found in Appendix A.

a. Create a new instance of the About Form

b. Show the About Form.

12. When Help > How menu strip item is clicked

(HowToolStripMenuitem _ Click ()) as shown in figure 44. The
complete VB code can be found in Appendix A.

a. Create a new instance of the HowToUse Form

b. Show the HowToUse Form.

13. When Help> Tutorials menu strip item is clicked (mnuTut _ Click ())
as shown in figure 44. The complete VB code can be found in Appendix
A.

a. Create a new instance of the Tutorials Form
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1. When the form is loaded (Result_ Load () ).The complete VB

code can be found in Appendix A.

a. Make the equasion panel visible (pnlEquasion).

b. Show the inputs and outputs taken from the Main Form into

the picture boxes (piclnputl, piclnput2, picOPl, picOP2,

picOP3).

c. Get the URL of the animation from the Main Form.

d. load the animationand playe it.

2. Afterfew seconds (3500 intervals) i.e. when the animation video is

over (Timerl Tick () ).The complete VB code can be found in

Appendix A.

a. Connect to the database and get the information in the

conclusion-experiments table

b. Find the conclusion ID from the table where the experiment

ID in the table= the experiment ID found in the Mian form.

c. Connect to the database and get the information of the

conclusions table.

d. Get the conclusion description from the conclusion table

where the conclusion Id in the table = the conclusion Id

found in the previous steps.

e. Get the result Title from the main form and display it in the

result name label (lblResN).

f. Get the result description from the main form and display it

in the result label (lblres).

g. Display the conclusion description found in the previous

steps in the conclusion label (lblConc).
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b. Fill the combo boxes with the list of chemicals and detectors

that were found in the main form.

2. When selecting an item from the chemicals combo box

(cmbChem _ Se l ectedTndexChanged ( ).The complete VB code

can be found in Appendix A.

a. Save the index of the selected item in a global variable.

b. Call the (check()) function that:

i. Chickes if the detector and chemical have been

chosen.

ii. If so, call the (findSteps()) function that:

1. Finds the chemical experiment that uses the

selected chemical and detector by finding all

the experiments of the selected chemical, all

the experiments of the selected detectors and

find the common experiment in the two lists.

2. Find the set of steps IDs by searching in the

experiments-steps table in the database where

the experiment ID in the table = the experiment

ID found in the previous step.

iii. After executing the (findSteps{)) function, the steps

descripting where found by searching in the steps

table in the database and get the description where

the step ID in the table = the steps IDs found In the

(findSteps()) function and display those descriptions in

the list box (lstStp).

3. When selecting an item in the detectors combo box

(cmbDet _ SelectedindexChanged () ).The complete VB code

can be found in Appendix A.
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a. Save the index of the selected item in a global variable.

b. Call (check()) function that is explained previously.

4. When clicking on the print button (btnPrint_Cl ick {) ).The

complete VB code can be found in Appendix A.

a. Create a new instance of a print document

(Printing. Print Document).

b. Give the print document the name "Bin Hayan Tutorial''.

c. Add a handler that calls the function (Print Page) that:

i. Define a font with specific font familly, size, and style.

ii. Define a margin bounds.

iii. Draw the text to be printed line by line . and the text is

taken from the form's labels,combo boxe, and list

boxes.

d. After executing the (printpage) function, the program give a

print order by calling (. Print {))

e. Display a list box stating the printing state.

5. When clicking on the Save button (btnSave _ C1 i. ck () ).The

complete VB code can be found in Appendix A.

a. Creating a save file dialog and name it "save file"

b. Assign the types string (filter) ("Text File 

( *. txt) I*. I AllFiles ( *. *) I*.*"). 

c. Display the save daialog.

d. Create a stream writer object with the name written in the

save dialog.

e. Write the text into the stream writer file line by line.

f. Display a message box stating the location of the saved file.

6. When clicking on the Close butto (btnClose_Click {) ).The

complete VB code can be found in Appendix A.

a. Close the current form (Tutorials Form).
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i5 ConcJ sion

This chapter represents updated design phase of the software. An 

pdated ER diagram was used to represent the database components and 

�eir relationships. The updated database helps to make the software eas

er to be implemented. The user interface design was then explained. Fi

nally, sequence diagrams were used to show the dynamic behavior of main 

icenarios. 
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Chapter 6
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6.3 Evaluation 

The evaluation of Bin Hyan Program was done by several people: our 

supervisor, Effat college faculty, and Chemistry lecturer from King Abdul 

Aziz. All the testers confirmed that it was user friendly software, easy to 

use and has a very clear interface that can be followed and track. 

The faculty from Effat College have tested the software during the de

velopment phase and recommended to enlarge the result animation for 

better observation, and fix the numbers of the chemical symbols - as they 

were as large as the letters-. We have taken her recommendations in con

sideration and enlarged the animation video, and used images instead of 

the text to overcome the symbol numbers' problem. 

The chemistry lecturer from KMU recommended to add more tools 

and encouraged us to add all the groups and chemicals and prepare it to 

be used in universities. 

6.4 Conclusion 

At the end, we tested the program with real data as will be shown 

before and it was error and bug free. Bin Hayan was user friendly software, 

easy to use and has a very clear interface that can be followed and tracked. 
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Chapter 7. CONCLUSION 

Because of the need of a technology tool that could contribute in 

finding a solution to save our environment and health from pollution, and 

the need of a tool to simplify the educational process in the chemistry 

field, a Chemistry Virtual Laboratory was selected as a title of this project. 

The senior project report introduced the idea of the project selec

tion as well as a complete study of the literature review going through all 

the factors related to the topic, studying similar products and data collec

tion all have been viewed in this report. In addition, a software require

ments specification and software design have been discussed in details. 

Moreover, it shows the implementation of the software. 

Working on this report gave us more knowledge about all the re

lated topics such as the chemical causes of environment pollution, educa

tion technologies, and chemistry related information. 

Participated in the Microsoft imagine cup 2008 competition was a 

huge challenge and a great experience for us. The community feed-back 

about the project in the competition is provided in the appendix. 

Finally, a complete tool Bin Hayan virtual chemistry lab has been 

implemented and deployed to help the students doing the chemical expe

riments. 

7.1 Difficulti� Faced 

While working on this report we have faced some problems and difficul

ties such as: 

• Finding the proper references and resources,

• Understanding chemistry concepts,
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• The time constraint was the major problem.

• learn new software 30 Max.

At the end, by the help of god, all of these difficulties have been managed. 

7.2 Future Plans 

For the future, we would like to enhance Bin Hayan project to be able 

to publish it in the universities and schools by: 

• Adding More Experiments. In this project we implement one expe

riment. So, we will add more experiments.

• Enhancing the design. We will redraw and adding some objects in

the 30 Max.

128 



References 



REFRENCES 

[1}.About Air Toxics 2007, U.S. Environmental Protection Agency, Avail

able at: http://www.epa.gov/ttn/atw/allabout.html 

[2).Ahmad Omar, Rafie Hassan, Sayed Ali (1992}, "�/ � �/ "'-'Jy.,J/ 

�W� 3th edn, Dar Alfonon, Jeddah. 

[3}.Air Pollution (2007), Wikipedia, Available at: 

http://en.wikipedia.org/wiki/ Air _pollution 

[4}.Animal Testing (2007), Wikipedia, Available at: 

http://en.wikipedia.org/wiki/ Animal_testing 

[SJ.Charles R. Magel, 'Animal Testing 101', People for the Ethical Treat

ment of Animals, Available at: 

http://www.stopanimaltests.com/anima IT estinglOl.asp ?c=satOl 13 

g&gclid=CN-Pw-DXx5ACFRZgMAodrRkNQA 

[6].Christian W. Dawson (2005), Projects In Computing and Information 

System: A student's Guide, Addison Wesley, Harlow England. 

{7].Clear Glass Material 2008, Available at: 

http://www.maxfanatic.com/ 

[SJ.Colin Baird (1995), Environmental Chemistry, W.H Freeman and 

Company, New York. 

[9].Dan Maharry , James Hnddleston , Ranga Raghuram , Scott Alleu 

Syed Fahad Gilani , Jacob Hammer Pedersen ,Jon Reid (2005) 

,Beginning VB.NET 1.1 Database from Novice to professional , 

Apress, New York. 

129 



[10]. Daniel E. Atkinson, Douglas C. Brower, Ronald W. Mcclard (1989),' 

Virtlab: A virtual Laboratory', N. Simonson & Company, Available at: 

http://www.virtlab.com/main.aspx 

[11]. Dewey J. 1938, Experience and Education, Collier Book, New York. 

[12]. Garrison J., Scheckler R.K. (2002), Prospectes and Possibilities, 

Erlbaum, New Jersey. 

[13]. Imagine Cup {2008), Wikipedia, Available at: 

http://en.wikipedia.org/wiki/lmagine _ Cup 

[14]. Imagine Cup: What is The Imagine Cup? (2007), Microsoft Corpo

ration, Available at: http://imaginecup.com/ About/whatls.aspx 

[15]. Jhon J. patrick (2002), SQL Fundamentals, 2en edn, Preutice Hall 

PTR, New Jersey. 

[16]. Joanne Penner (2001), 'The Virtual Laboratory Environment', P. 

Pusirkiewicz the University of Calgary, Available at: 

http://pages.cpsc.ucalgary.ca/"'pwp/bmv/vlab-for-linux/html

docs/environment. html 

[17]. Joseph Bergin (2002), 'Virtual Computer Science Laboratory: An 

OOPSLA 2000 Design Fast Exercise', pace University, Available at: 

http://www.csis.pace.edu/"'bergin/papers/virtualCSLab.html 

[18]. Lan Somerville (2000), Software Engineering, 6th edn, Addison 

Wesley, Harlow England. 

[19). Maya {software) {2008), Wikipedia, Available at: 

http://en.wikipedia.org/wiki/Maya-%28software%29 

[20). Model Chemlab (2008), Model Science Software, Available at: 

http://modelscience.com/products.html?ref=home&link=chemlab 

[21]. Nikos Auradinis, Spyros vosinakis, Themis Panayiotopoulos (2000}, 

'Using Virtual Reality Techniques for the simulation of Physics Expe

riments', Virtual Engineering and Emergent computing, vol. 111, no. 

2, pp. 6-11. 

130 



[22]. Rebecca K. Scheckler (2003),'Virtual Labs: a Substitute for Tradi

tional Labs', The International Journal of Development biology,

vol.47, no.2-3, PP.231-236.

[23]. Rockville Pike, Bethesda (2007), National Institutes of Health,

Available at: http://www.nlm.nih.gov/medlineplus/airpollution.html

[24]. Scheckler R. (2000), Weaving Feminisim, pragmatism, and dis

tance education: In Curriculum and Instruction, Virginia Polytechnic

Institute and State University, VA.

[25]. Toxic Chemicals (2007), World Wildlife Fund, Available at:

http://www.worldwildlife.org/toxics/

[26]. Turbo Squid 2008, Turbo Squid Inc, Available at:

http://www.turbosquid.com/

[27]. Water Pollution (2007), Microsoft Corporation, Available at:

http:// encarta .msn .com/ encnet/refpages/Ref Article .aspx ?refid= 761

572857 

[28}. Water Pollution Effects (2006), Mark Jeantheau, Available at:

http://www.grinningplanet.com/2006/12-05/water-pollution-

effects.htm 

[29]. Wilhelm Huisinga ,Regina Telgmann ,Michael Walkow (2006) ,'The

virtual Lab Approach to Pharmacokinetics :Design Principles and

concepts' ,Periodical Drag Discovery Today ,vol. 11,no. 17-18,PP.

800-805.

[30]. William H. Dutton, Brain D. Loader (eds) (2002), Digital Academe:

The new media and institutions of high education and learning,

Routledge, New York.

131 



Appendix A 

VB Code 



APPENDIX A. VB CODE 

Publ::.c- Clas Start 

Pub��c chapfrm As ChaptersForm 
PL -a �ub btnPlay_Click( ·y' ·L sender '\s System.Object, By-Va� 
e A System. EventArgs) landlE's btnPlay. Click 
chapfrm = New ChaptersForm 
Me.Hide() 
chapfrm. ShowDialog () 
F.nd Sub 

�- a Sub Start Load(ByVal sender System.Object, ByVdl e 
,s System.EventArgs) d d s 'y a .Load 
AxWindowsMediaPlayerl. URL = " 
AxWindowsMediaPlayerl.Ctlcontrols.play() 
Timerl. Enabled = �rue 
End Sut 

Priva e ub Timerl_Tick(ByVa sender A. System.Object, uvV _ e 
As System.EventArgs) landles Timerl.Tick 
AxWindowsMediaPlayerl.Ctlcontrols.pause() 
End Sub 
End Class 

Publ c Class ChaptersForm 
Pub__ SecFrm As SectionsForm 
:Jim chap A S .. �i g 
fubl_c chapID As S ring 
Priva e Sub ChaptersForm_Load (ByVa 
ByVal e A� System.EventArgs) Hand�e 

. 'r f E r 

sender As System.Object, 
MyE, e.Load 

ne 
Me.ChaptersTableAdapter.Fill(Me.DatabaseDataSet.Chapters) 
End Sub 

rr1vate Sub btnCancel_Click(ByVal sender As System.Object, 
ByVa� e As System.EventArgs) Hand e btnCancel.Click 
Me.Close () 
End Sub 
Pr1va Sub btnNext_Click(ByVa_ sender As System.Object, ByVal 
e A. System. EventArgs) hn::lle: btnNext. Click 
Me.Hide () 
chap = 
(comboChapters.GetltemText(comboChapters.Selecteditem())) 
chapID = 
ChaptersTableAdapter.getID(chap) .ToString() .Trim() 
Se cFrm = New SectionsForm 
SecFrm.ShowDialog() 
�nd i b 

End C-ass 
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Chemistry Lab Data 
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Appendix E 

Design Sketches 
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